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                 PPreface

What is Image Workshop?  Image Workshop is software for the scientific study of image data.  It is designed 
to not only display images from remote sensing and medical devices, but also to aid in the extrapolation of  
data  from such images.   This  process  is  facilitated  through the  use  of  Image Workshop's  built-in  image  
enhancement tools and palettes.   These tools and palettes include a set of drawing and painting devices, as 
well as tools that let you add layers on top of images, hilite specific color values via the color palette, work  
with several images at once, customize the image display, and compute 3-dimensional images.  We hope that it  
serves you well.  

      



      

    

Introduction I

The following section outlines the hardware requirements for running Image Workshop, how run the program 
effectively, the file types that Image Workshop can display, and the purpose of this manual.       

       

      



      

HARDWARE REQUIREMENTS

Image Workshop will run on any Macintosh that meets the following requirements:

• Macintosh running Color Quickdraw
• 68020 processor or greater
• Mac II or later
• System 7.0 or later, 32-bit mode (older machines        require  either 

Mode32 or the Apple 32-bit Enabler–    
               both available through ftp or on-line services)

 • 4 Megs required; 8 recommended
 • 2 Megs of hard drive space required.

RUNNING IMAGE WORKSHOP

Before you run Image Workshop, please make sure that the following five items are located within 
the Image Workshop folder:  

There are just a few things you should know about how to run Image Workshop effectively.  First,  
you can store images in either the Image Workshop application folder, or in a separate image folder.  
Also,  at  startup time,  Image Workshop scans recursively,  looking for color tables and external 
modules to add to itself.  Therefore, the program's loading time can be reduced by preventing it  
from scanning folders that do not contain color tables or externals, which is done simply by adding 
an option-8 (•) to the beginning of the folder's name.  For example, the folder "•Images" will not be  
scanned because it does not contain any color tables or externals.

FILE TYPES

Image Workshop can display the following types of image formats:

•  Raw images
•  PICT files
•  QuickTime
•  Images created with Imagic
•  Images saved with Image Workshop 

      



      

EXTERNALS

You can also add externals to Image Workshop to add functionality, such as file readers, filters and  
color tables.  Simply place these in either the Image Workshop Externals folder or the Color Tables  
folder.  This placement is not required, but recommended.  (They can be placed anywhere within 
the Image Workshop folder hierarchy).

ABOUT THIS MANUAL

This manual presents a detailed description of how to work with Image Workshop.  However, despite these 
descriptions, the manual also assumes that you are familiar with the Macintosh.  If you have any problems 
with the basic functions and commands, consult your Macintosh user's manual. 

The  first  few  chapters  explain  the  functions  of  the  tools,  palettes,  commands,  and  functions  of  Image  
Workshop, whereas the last chapter offers you the opportunity to work with the program via a structured, 
hands-on learning session.  While working with Image Workshop, remember that the "don't save" option is 
always available, so don't hesitate to try out each function for yourself.

This manual was created on a Macintosh IIfx using Microsoft Word 5.1, Canvas 3.5, and Image Workshop.

Note:  It may be useful to print this manual to better illustrate the figures and pictures, if 
you haven't already done so.

      



      

Chapter Image Windows

1

The most basic element of Image Workshop is the "Image Window."  Image Windows can be 
dragged, re-sized, minimized, and scrolled through just as any other window on your Macintosh. 
The following section outlines the main functions of Image Windows.

      



      

As stated previously, Image Windows are used to display images.  A sample Image Window is shown below in  
Figure 1.1, displaying the image file "Colorado NDVI & Map."   

           

Figure 1.1

Note:  A description of how to open an Image Window is found in Chapter 3 on page 15.

In addition to the normal scroll bars, there are a few other features included in the Image Window:  
the zoom command boxes and the Layer Manager Menu.  These are described in the following 
two sections.

Note:   The  Image  Window's  size  is  limited  by  the  maximum  size  shown  in  the 
percentage display  box.   For  instance,  each display size (50%, 100%, 200%, 400% 
etc…) has a maximum size that it can be re-sized to.

ZOOM COMMANDS
The two zoom commands, zoom in and zoom out, increase and decrease the magnification factor used to 
display the image.  To use these commands, simply click in either of the two zoom boxes, as shown below in  
Figure 1.2.

      Figure 1.2

      



      
  

By clicking in the zoom in box, the image display size is multiplied x2.  This is especially useful  
when you need to view an image with greater detail.   Conversely, zoom out cuts the image size 
by 50%.  And to return the image to the 100% view after either of these operations, simply click in 
the percentage box. 

                 

LAYERS
Another special feature of Image Workshop is the ability to add layers 
on top of your original images.  The  Layer Manager helps to add, 
delete, and rename such layers to images.  Possible layers are, among 
others, contour lines, fill-patterns, shapes from the Tools Palette, and 
enhanced layers.  

Each of the functions of the tools used for layering are applied to the 
currently selected layer in the Image Window.  Exceptions to this are 
the  tools  that  effect  the  size  of  the  image,  such  as  add  border, 
reduce/enlarge, and the zoom commands.  These size-altering tools 
effect all layers within the current Image Window. 

For instance, to add contour lines to your image as a separate layer, 
simply select  contour from the  Options Menu.   The two images 
below illustrate a single-layer image and a multiple (2-layer) image.

                                     

     Single-Layer Image                      2-Layer Image
 Figure 1.3

After the contour layer has been computed and added to the image,  you may either "hide" or  
"show" the contour lines.  To hide the lines, simply select hide layer from the Layer Menu, as 
shown below in Figure 1.4.   

      



      

                                              Figure 1.4

To redisplay (show) the layer, select the layer "Contour" from the bottom of the Layer Manager 
Menu.  Hidden layers are marked with a "◊" and the active image is marked with a "".

Select Layer Manager from the top of the Layer Manager Menu to add, delete, load, rename, lower, and 
raise layers within the current Image Window.  The Layer Manager dialog box is then displayed, as shown 
below in Figure 1.5.  

  Figure 1.5

The current image's layers are listed on the left side of the dialog box in descending order (top layer  
on top; bottom layer on bottom).  The right side of the dialog box contains six functions.  Load 
opens a dialog box that you can select images to add as layers.  Add layer adds the selected layer. 
Delete simply deletes the current selection.  Rename lets you rename a selection.  Move up 
moves the selected layer  up to  the next  level  of  the layers,  whereas  move down moves the 
selected layer down a level.  

      



      

   

Chapter Workshop Palettes

2

Now that you understand what is displayed in the Image Window, the following section describes 
the  palettes  that  color,  enhance,  manipulate  etc.  your  images.   These  palettes  are  "floating 
windows," and are, therefore, displayed on top of other open windows to allow for constant access  
to all of the Image Workshop tools.  No longer do you have to dig through endless windows to find  
the right palette!         

      



      

TOOLS PALETTE

This section describes each of the different tools available within the Tools Palette, as illustrated 
below in Figure 2.1.  

Figure 2.1

As you can see, the Tools Palette contains some basic instruments for drawing, labeling, painting, 
graphing, and moving images.

Note: The rectangle, rounded rectangle, and circle tools can all be set to draw 
from a center point. 

     Area Selection 

The  area selection  tool is used to select a rectangular section of an image so that it may be 
moved, copied, cut, pasted, or cropped.  Click on a beginning point, drag to an end point, and then 
release to select the desired region.      

    Hand 

Selection of the hand tool allows you to move an image within the Image Window. The hand tool 
works as if you were using your own hand to slide the image on a desktop.  Simply select the tool,  
click on a point, and drag the hand on top of the image.  

Text  

The  text  tool is used to superimpose text onto an image.  Select the  text tool from the  Tools 
Palette and click on an area in which the text is to appear within the image.  To change the text's 
attributes (font, size, justification, and style), use the Text Menu as described in Chapter 3 on page 
28. 

      



      

     Pencil 

The pencil tool can be used to draw on an image just like a real pencil.  Select the pencil tool, 
click on a starting point and drag the pencil to create freehand lines.

     Eraser

By selecting the eraser tool, you can erase both small and large areas of an image by zooming in 
or out to change number of pixels covered by the eraser tool.  Just click and drag over the part of 
the image that you want to eliminate.

     Fill Tool (Paint Bucket)

The fill tool is used to fill an area with the current color, which is  selected in the Color Table. 
For more information on selecting colors from the  Color Table, see Chapter 2 on page 9. 

     Paint Brush

The paint brush works like a real paint brush to color a selected region.  The paint brush, like 
the pencil tool, uses the current color selection from the Color Table.  Click on a point and drag 
to paint.  Simply zoom in our out to change the size of the Paint Brush.

     Line Tool

The line tool is used to draw lines on an image.  Click on a starting point and drag to an end point. 

     Rectangle

The rectangle tool is used to draw rectangles on an image using the current color selection from 
the Color Table.  Click on a starting point, drag, and release to complete the rectangle.  The Fill 
Patterns Palette allows you to fill rectangles with a number of different patterns.  To make the  
center of the rectangle the starting point, double-click on the tool's icon in the Tools Palette.  A 
"+" will be placed in the center of the icon to illustrate that the "center-draw" feature has been 
activated.  

Note:   Chapter 2 on page 10 offers a detailed description of how to use the  Patterns 
Palette for filling in rectangles. 

      



      
     Rounded Rectangle 

The  rounded rectangle tool draws rectangles with rounded corners and can be filled like any 
other shape by using the Fill Patterns Palette.  Double-clicking on this tool, like the rectangle 
tool, causes the starting point to become the center of the rectangle.

     Circle 

The circle tool can draw both circles and ovals, and can be similarly  filled in like the other shapes.  
By double-clicking on this tool, (just as the two rectangle tools) the starting point becomes the 
center of the circle.

     Polygon 

Not working yet.  

     Freehand

The freehand drawing tool allows you to create freehand shapes.  This is similar to the pencil 
tool, except that the lines drawn with the freehand tool will always create a closed image that can 
be filled in with color and fill patterns.  See Chapter 2 on page 10 for more on how to fill in  
freehand objects using the Pattern Fill Palette.

     Dropper 

The  dropper tool is used to select a color that you want to duplicate directly from the image 
without having to use the Color Table to find the exact color.  You can then fill any area with the 
selected color by clicking (with the dropper tool) on the area to be changed. 

     Graphing Tool

By selecting the graph tool, you can click on any two points of an image and a two-dimensional 
cross-section of the area between the points is computed and displayed.  This chart also includes the 
image name, starting point, and the end point.  

     Inspect 

The inspect tool provides information on the values of an image's individual pixels.  Not working 
yet.

     Label  

The value of an image's individual pixels can be placed on the image by using the label tool.  First, 
click on the label tool. Then click on any point on the image, and the value of that point will be  
labeled.  

      



      
It may be useful to increase the image's magnification factor (with the zoom tools) to view smaller 
fonts.    

Note:  Use the pull-down Font Menu to change the attributes of the label tool's text, as 
described in Chapter 3 on page 28.

     Nudge  

The nudge tool moves an image in any direction a user-defined number of pixels.  Click on two points, as  
you would to draw a line, and the image will be "nudged" that many pixels in the direction of the line.  To gain  
more precise movements with the nudge tool, hold down the shift key and double-click on one of the four 
directional arrows.  This will allow you to enter the value which the image is nudged by.  The nudge tool can 
also be accessed and "torn away" from the Edit Menu.

                

COLOR TABLE

The Color Table, as shown below in Figure 2.2, not only displays each of the color values of an 
image, but can also be used to change the colors of objects created with the Tools Palette.  To 
display  the  Color  Table,  simply  select  Show Color  Table from the  pull-down  Windows 
Menu.    

     Figure 2.2

The Color Table's display may seem rather simple; however, the information that it provides is very useful.  
The table itself consists of 255 squares, each representing a different color value.  Click on the individual 
squares to display the index number, which is located at the bottom of the Color Table.  

These index numbers also represent the values found in the Location Palette.  Click on any point on an 
image to find it's value, 

      



      
which is displayed in the Location Palette.  If, for instance, the color value from the Location palette is 
130, then the color for the index number "130" is hilited on the Color Table.  

Note: The Location Palette is discussed in Chapter 2 on page 12.

As stated above, the Color Table can be used in conjunction with the instruments in the Tools 
Palette to change the colors of lines, shapes, fill patterns, text, and the like.  Simply click on a 
particular color on the Color Table, and any tool that you use will utilize that particular color.    

If the color tables provided with Image Workshop do not "match" a particular image that you are working 
with, use the Edit Color Table command from the Options Menu.  The Edit Color Table command is 
explained in Chapter 3 on page 22.

Note: The minimum and maximum calibration values for the Color Tables are 0 and 255, 
respectively.  

PATTERNS PALETTE

The Patterns Palette, shown below in Figure 2.3, displays the different fill-patterns available for use with 
the instruments of the Tools Palette.  Just as selecting a color from the Color Table changes the color of a 
chosen tool, a selection from the  Patterns Palette  changes the fill-pattern of the object.  The  Patterns 
Palette is found in the pull-down Windows Menu.  

                                               Figure 2.3

The Patterns Palette can be "torn away" from the Windows Menu by dragging it to the right.  Click in the 
"close window box" located in the upper-left corner of the Patterns Palette to put it away.

      



      

COLOR SMEAR PALETTE

The Color Smear Palette, as shown below in Figure 2.4, displays the current Color Table.  Select show 
color smear palette from the pull-down Windows Menu to display this handy palette.   
  

   Figure 2.4
               
A function used concurrently with the  Color Smear Palette and  Color Table is  hilite.  It is 
used to hilite any given range of color values within the Color Table.  Simply select  set hilite 
from the Options Menu and enter the desired range to be hilighted. 

Note:   This  value,  or  value  range,  must  fall  between  0  and  255,  the  minimum and 
maximum values allowed. 

For instance, a hilite range of 20 can be set by entering "0" thru "20" as minimum and maximum 
values, respectively, in the set hilite dialog box.  This range can then be dragged along the Color 
Smear Bar in the Color Smear Palette to hilite any 20-value set between 0 and 255. 

The set hilite dialog box is also used to change the color of the hilite.  Click color to open the 
"Pick a Hilite Color" dialog box, which offers finer adjustments to the color's  hue, brightness, 
saturation, and RGB levels.  Click OK when done.  

ENHANCEMENT PALETTE  

The  enhancement  features  of  Image  Workshop  enable  you  to  remap  an  image's  Color  Table.   The 
Enhancement Palette, as shown below in Figure 2.5, consists of an Image Histogram which shows the 
number of occurrences of each pixel value, a Color Table which illustrates the current colors available, a  
palette of Enhancement Tools, as well as pre-defined Auto, Linear, and Integrate enhancements.

      



      

  Figure 2.5
             

The instruments of the Enhancement Tools Palette include a pencil, a segment tool, a line tool, and a 
slider.  These tools let you customize the enhancement of an image.  

The pencil in the Tools Palette allows you to draw an enhancement function.  The line draws lines.  The 
arrow tool lets you drag control points on the Image Histogram.  And the  slider  moves the enhancement 
function left or right.

The pre-defined enhancements (auto,  linear, and integrate) each create enhanced images that "bring out" 
certain features of an image that you want to hilite, and to subdue the undesired features. 

Auto finds the beginning and end of the Image Histogram and then puts the Color Table between those two 
points.  The  linear  function simply puts the  Color Table  to 0-255.  Integrate changes the slope of the 
Color Table to  match the  slope  of  the  Image Histogram to  get  the  best  possible  color  variation.   The  
derivative of the Image Histogram is used to integrate the color table along the histogram in the  integrate 
enhancement.

Again,  since  the  "don't  save"  option  is  available,  try  out  each  of  these  useful  enhancement  features  for 
yourself.

LOCATION PALETTE
               

Another handy palette in Image Workshop is the  Location Palette, shown below in Figure 2.6.  When a 
pointer tool is moved across an image, the Location Palette displays the coordinates of the point from the 
image.  Also displayed is the color value of the selected point, which corresponds to the pixel value found in  
the Color Table. 

      



      

           Figure 2.6

The lower section of the Location Palette displays scaled (user-defined) X and Y coordinates, as 
well as scaled values for each coordinate.  These can be entered in the  Edit Image Info dialog 
box.  Change both the low and high scale values and the units for customized cooridinates and 
units.  For example, enter 1,000 and 10,000 as the  low and  high scale  values, and change the 
units to "feet" to illustrate elevation.

Note: Edit Image Info is described in Chapter 3 on page 16.

      



      

      
Chapter Menus & Commands

3

Image Workshop has six major pull-down menus:  File, Edit, Options, Enhance, Text, and Windows. 
These main menus are described in the following six sections.

      



      

FILE MENU
The File menu contains the most basic functions for opening, closing, 
saving, and printing files.  These are outlined in the following sections. 

    New

To open a new Image Window, select new from the File Menu.  Next, 
enter the size of the image that you want to create by entering the X 
and Y dimensions in the  New Image Size dialog box.  Then click 
Create to open the new Image Window.  

     Open

To open an image file, select open from the pull-down Edit Menu, as 
shown below in Figure 3.1

       Figure 3.1

Next, you simply need to find your image folder in the dialog box and select the image file that you 
want to open.  

The open file dialog box, shown below in Figure 3.2, will then  prompt you to enter both the X 
and Y dimensions, the bits per pixel, and the header bytes to skip.  

      



      

  

Figure 3.2

Special format not working yet.

Click in the "Read Until End of File" box to automatically select the Y dimension.  The last action 
is to click OK when all of the fields are completed in order to open the file.  This will open a new 
Image Window to display the image.  The tutorial, found in Chapter 4 on page 32, goes through a 
sample opening of an image file in more detail.

     Open Several

If you want to open more than one image file at a time, simply use the open several command. 
Select the files to be opened, click the add button in the dialog box, and then click done.  All of 
the selected/added images will  be opened simultaneously.   To move between Image Windows,  
simply click on the window that you would like to work with.  The rotate windows command, 
detailed in Chapter 3 on page 29, also maneuvers between Image Windows.

     Image Info

The image info command displays the basic information about the current image.  This includes 
the file's name, size, pixel depth, center point, vertical range, projection type, low scale, high scale, 
and units of measurement.  The  image info box also has a  description box  so that a more 
detailed description of the image can be entered.  

To alter the center longitude and latitude, latitude range, low and high scales, units, projection, and  
description of the image, click on edit within the image info dialog box.  The Edit Image Info 
dialog box, shown below in Figure 3.3, lets you make these changes.

      



      

          

Figure 3.3

   

Click OK to finalize the changes to the image info.

     Create Animation

The  File Menu also contains the  Create Animation command, which can be used to create 
Quick Time movies from your images.

    Quit  Q⌘

The quit  command quits Image Workshop.  Before completely closing the program, you will be 
prompted to save all open Image Windows that have not been saved.

EDIT MENU
The  Edit Menu contains  the  commands  for  editing  images  and 
portions of images.  

Note:   Using  cut, copy, paste, crop  selected  area, add  color  bar, and compute 
statistics require that an area has been selected with the area selection tool.

     Undo   Z⌘

The undo command allows you to undo your last action from the Edit Menu.  

      



      
     Cut  X⌘

The cut option "erases" an area selected by one of the Image Workshop tools (such as the  area 
selection tool) and places it in the clipboard.

     Copy  C⌘

The copy command is used to copy a region selected by one of the Image Workshop tools.  Use 
the paste command to paste the region elsewhere.

     Paste  V⌘

Paste, used with the copy command, "pastes" a selected region from the clipboard. 

     Clear

The clear command clears a selected area on an open image.

     Duplicate  D⌘

Duplicate makes a duplicate of a selected region.

     Select all   A⌘

Select all selects the entire image in the Image Window.  

     Flips and rotations 

The  flips and rotations table,  shown below in Figure 3.4,  allows you to flip  entire  images 
horizontally, vertically, or diagonally.  Rotations of 90 degrees (clockwise and counter-clockwise) 
can also be done using the rotation commands.

R

             Figure 3.4

      



      

     Nudge 

The Nudge Palette offers the same functions as the nudge tool in the Tools Palette and can be 
"torn away" from the Edit Menu simply by dragging it to the right.  The Nudge Palette is shown 
below in Figure 3.5.  

                                          

Figure 3.5

To use this tool, simply click on two points, as you would to draw a line, and the image will be  
"nudged" that many pixels in the direction of the line.  Shift-double-click on any one of the arrows 
to enter a more precise movement.

     Crop selected area

This command provides a shortcut for selecting, copying, and pasting a section of an image to 
another Image Window.  Crop selected area creates a new Image Window for any area that has 
been selected with the  area selection tool and pastes the area to the new Image Window, thus 
creating a new image.  

     Crop explicit area

The  crop explicit area works in the same way as  crop selected area, but it allows greater 
control over the size of the region that you wish to select.  Select  crop explicit area from the 
Edit Menu and enter the four boundary values for the area to be selected.  Then click OK and the 
region will be displayed in a new Image Window.

     Reduce/Enlarge

Select reduce/enlarge from the Edit Menu to reduce or enlarge the size of an image.  Both the 
image's width and height can be changed by modifying the X and Y value in the reduce/enlarge 
dialog box, which is shown below in Figure 3.6.  Reduce/enlarge effects all layers in the Image 
Window.

      



      

      Figure 3.6

To reduce an image's size, enter percentages less than 100.  Conversely, percentages larger than 100 
will  enlarge  the  image.   For  example,  entering  50% will  reduce  the  image  by  50%,  whereas 
entering 150% will enlarge the image.  

    Add color bar 

The add color bar command superimposes a vertical or horizontal color bar on an image.  Select 
a region with the  area selection tool and choose  add color bar  from the  Edit Menu.  The 
submenu shown below will appear.

              Figure 3.7

There  are  four  different  configurations  of  color  bars  that  you  can  add  to  the  selected  region: 
horizontal with the color values on the top or bottom, and vertical with the color values on the right  
or  left  of  the color bar.   Simply choose one of these configurations from the  add color bar 
submenu.  

Note:  The default size of the text displayed with the color bar is 9 point.  If you wish to  
use a larger type, simply select a different size from the Text Menu before creating a color 
bar (the text size cannot be changed once the color bar has been placed).

      



      

     Compute statistics

Compute statistics creates a dialog box, shown below in Figure 3.8, that displays the minimum 
and maximum values, the average value, as well as the standard deviation. 

             Figure 3.8 

This command can be used to display the statistics for either a  selected region or the entire image.   
Computing the  statistics  of  an   image is  a  quick way to  get  basic,  but  useful,  information as 
illustrated above.

     Preferences  Y⌘

The preferences dialog box lets you set the some of the default parameters, including a printing 
option and the "show active layers when painting" option.  The  preferences dialog box also 
allows you to set the low and high calibration values, as well as calibration units.  The bottom 
section of the dialog box contains the options for setting the image compressor.

         

OPTIONS MENU

The  Options Menu contains commands for changing colors, adding borders and contour lines, 
combining images, calibrating values, setting hilites, and marking coordinates.  These are outlined 
in the following sections.

     Color tables

      



      
The Color Tables submenu allows you to change the display colors to suit your particular image. 
As described in Chapter 1, Image Workshop scans for Color Tables at startup time.  These Color 
Tables can be displayed and utilized by selecting Color Tables from the Options Menu.  The 
following figure depicts the Color Tables that come with Image Workshop.

              

Figure 3.9

Also, the edit color table command enables you to alter the existing color tables, as well as create 
new color tables.

     Edit color table  E⌘

This option allows you to edit and customize color tables for your images if the ones provided do 
not suit your particular needs.  The edit color table dialog box is shown below in Figure 3.10.

  

Figure 3.10

      



      

The top section of the edit color table dialog box lets you select one of four views to be used in 
conjunction with the  Color Table.  The first view is the  Palette view, which displays a  Color 
Table on the right side of the dialog box.  Similarly, the other three views (red-green-blue, cyan-
magenta-yellow, and hue-saturation-brightness) display their respective views of values, or range of  
values, of the Color Table.  For instance, the RGB view shows the amount of red, green, and blue 
within the pixel selected from the Color Table.  

As you can see in Figure 3.10 above, the left side of the Edit Color Table dialog box holds seven 
functions, as well as tools for increasing the brightness, RGB, and CYM for a selected pixel.  These  
seven tools are:  picker, smear, cycle, reverse, contrast, posterize, and generate. 

The  picker allows you to change a single color.  The  smear  function produces a linear smear 
between the endpoints of a range of RGB colors.  Similarly, cycle produces a linear smear between 
two endpoints for a range of RGB colors.  Reverse simply "swaps" the color positions of a range 
of colors.   The  contrast  function contrasts  colors in increments and decrements.   Posterize 
reduces the number of colors in a selected range.  Finally,  generate randomly generates a new 
color table.

The lower left side of the dialog box contains the basic commands for saving new color tables,  
reverting to original color tables, and "undoing" actions while editing color tables.

Don't worry, if the color table that you are editing does not turn out the way that you expected it to.  
Simply use the  revert command to revert to the original color table.  Also, clicking  undo will 
undo your last action. 

Note:  For more information on editing color tables, a step-by-step example is given in the 
tutorial.    
  

     Add border

With the add border command, a user-defined border can be added to all layers of an image.  Just  
enter the border width for each of the four sides and click OK.  This option adds a border to the  
edges of the image and does not eliminate any part of the image itself. 
                 

      



      

     Contour

Contour  creates  a  customized contour  map of  any image.   Enter  the values in  the  Contour 
Settings dialog box, as illustrated in Figure 3.11 below.

          

   Figure 3.11

First, select the starting and ending values for the contour map in the dialog box.  These values  
must lie within the calibrated values of the Color Table.  Then enter the contour interval, number 
of minor contours, smoothing parameter, and skip value.  Click OK and a contour map layer will be  
drawn on the image.  (For more on layers, see Chapter 1 on page 3).

     Combinations

When more than one Image Window is open, the combinations command can be used to create 
"mixes"  of  two or  more  images.   You can  add,  subtract,  multiply,  or  divide,  any images 
together, as well as use the and, or, and Xor commands to combine images. 

Again, since the "don't save" option is always available to you, try out each function for yourself. 

     Composites

The composites command creates composites of images by allowing you to set the maximum, 
minimum, average, median, and RGB values.  

    Set hilite  U⌘

Hilite is a function used concurrently with the  Color Smear Palette.  It is used to hilite any 
given range of color values on an image.  

      



      
Simply select set hilite from the Options Menu and enter the desired range to be hilited.  This 
value must fall between 0 and 255, the minimum and maximum values allowed.  For instance, a  
hilite range  of  20  can  be  set  by  entering  "0"  thru  "20"  as  minimum  and  maximum  values, 
respectively.  This range can then be dragged along the Color Smear Bar in the Color Smear 
Palette to hilite any set of 20 between 0 and 255.  

Note:  The Color Smear Bar,  Color Table, and Color Smear Palette are explained in 
Chapter 2, and an example the hilite command is given in Chapter 4:  A Quick Tutorial, 
found on page 40.

 
    Mark coordinate  L⌘

Mark coordinate marks any selected point on an image with one of three symbols:  x, +, or •.  
Simply enter the latitude and longitude, and select a marking device from the mark coordinate 
dialog box to utilize this feature. 

ENHANCE MENU
Some  of  Image  Workshop's  most  useful  features  are  found  in  the 
Enhancement  Menu.   The  enhancement  functions  allow  you  to 
enhance  your  images  to  emphasize  specific  features  of  the  image. 
These functions are outlined in the following sections. 

     Enhance  E⌘

For a detailed description of the  enhance  command and the  Enhancement Palette, refer to 
Chapter 2 on page 11.

     Borrow enhancement B⌘

The borrow enhancement feature simply borrows an enhancement from another image.  See the 
section on the Enhancement Palette in Chapter 2 on page 11 for more on enhancements. 

     Filters

Image Workshop allows you to impose four different filters on your images, as shown below.

Figure 3.12

      



      
They include median, mean, and shadow filters, as well as a custom mask filter that lets you to  
customize  the  values  in  the  spreadsheet  matrix,  which are  the  weights  that  are  applied  to  the  
varying pixels.

     Change pixel value  T⌘

Change pixel value enables you to change the value of an individual pixel.  Just enter both the  
pixel value to be changed and the new pixel value in the dialog box to change the value, as shown 
below in Figure 3.13.

                             

  Figure 3.13

     Shift pixel values

You can  also  shift  the  values  of  any  given  range  of  pixels  by  using  the  shift  pixel  values 
command.  The shift pixel values dialog box 
is shown below in Figure 3.14.

                          Figure 3.14

Enter the low and high values of the range to be shifted and the number of pixels that the range is 
to be shifted by.  

     Compute 3-D

Another useful feature of Image Workshop is the compute 3-D function.  Compute 3-D, in the 
Enhance Menu, creates a dialog box, as shown below in Figure 3.15.
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   Figure 

3.15
       

The left side of the Compute 3-D dialog box contains the 3-D image surface grid, which displays a  
grid in accordance with the X, Y, Z, and Z-scale coordinates on the right side of the dialog box.

The image is first drawn in an overhead view, but can be rotated in any direction to display different 
perspectives.  Click and drag on any point on the image surface grid within the dialog box and the  
new perspective is automatically drawn.  

You may also change the perspective by entering new X, Y, Z, and Z-scale coordinates.  Pressing 
the tab key after each new coordinate is entered creates a new image surface grid that  can be  
computed into a 3-dimensional image.  

Below the coordinates list is the "draw axis" box.  Click in this box to draw the X and Y axis on the  
3-dimensional image.

Another option in the dialog box is the Shade Surface Menu. This option allows you to select 
any of the open Image Windows to be used as surface shaders.  Simply click on the menu and select  
an image.

When  you  have  found  the  "correct"  perspective  for  creating  a  3-dimensional  image,  click  on 
Create.   Image Workshop will  then take a moment to create a  new Image Window and a 3-
dimensional image.  The 3-D view of "Colorado NDVI" is shown below in Figure 3.16. 

      



      

   Figure 3.16

Note:   A step-by-step description of this command is given in the Tutorial.

TEXT MENU

Image Workshop also offers a range of different font sizes and styles for writing on and labeling 
images.  These text options are outlined in the following sections. 

     Font 

Simply select any font installed on your Macintosh from the font submenu and use the text tool 
from the Tools Palette to write on your image.

     Size

The size submenu simply selects the text size.  

     Style

Style refers  to  the  attributes  of  a  font.   The  style submenu  effects  include  plain  text,  bold, 
underline, outline, shadow, as well as condensed and extended text.  Select any of these styles from 
the style submenu.

     Align left

Align left simply left-justifies text that you type on an image. 

      



      
     Align center

Align center centers text that you type on an image.

     Align right

Align right right-justifies text that you type on an image.

WINDOWS MENU

The Windows menu offers all of the tools necessary to keep the palettes and windows of Image Workshop 
where you want them on the desktop.  The major functions of the Windows Menu are outlined below. 

Note:  Each "hide" option has a converse "show" option, such as "hide color palette" will 
show the color palette after it has been hidden.

     Hide  H⌘

The  hide command hides whatever Image Window is currently open.  See the  show all or the 
open images display sections below for information on "unhiding" Image Windows.

     Hide all

Hide all hides all of the open Image Windows on the desktop.

     Show all

Show all displays all hidden Image Windows on the desktop.

     Close all

Close all closes all open Image Windows.

     Rotate windows  R⌘

When there are two or more Image Windows on the desktop, the  rotate windows command 
rotates between the open windows.  This tool is pretty handy for working with multiple images.

     Show clipboard

The show clipboard command displays the clipboard and any text or graphic element within it.

      



      
     Show/Hide color table palette

This command simply shows or hides the Color Table.  For more on this palette, see Chapter 2 on 
page 9.

     Show/Hide location palette

This command shows or hides the Location Palette.  For more on this palette, see Chapter 2 on 
page 12.

     Show/Hide color smear palette

This command shows or hides the color smear palette.  For more on this palette, see Chapter 2 
on page 11.

     Tools

This menu item simply displays the Tools palette, as discussed in Chapter 2 on page 6.

     Patterns

The  Patterns Palette is used to fill in objects created with the Tools Palette.  For more on this 
feature, see Chapter 2 on page 6.

     Line size

The  Line Size Palette allows you to select the line width for use with the tools in the  Tools 
Palette.

     Open Images Display 

Open  images  display  simply  lists  the  Image  Windows  that  are  currently  open  in  Image 
Workshop. 

      



      

Chapter A Quick Tutorial

4

Running through this tutorial should also be painless.  By this point, you know that Image Workshop is easy to 
use and that most of the commands and functions are somewhat obvious; however, just in case you missed 
something,  the  following  tutorial  provides  a  step-by-step  introduction  to  guide  you  through some of  the 
processes.  The tutorial is, hopefully, more than a simple descriptive list, but rather a working example that 
shows you how to utilize most of the tools, commands, options, and functions of the program.  It should only 
take a few minutes to complete.

      



      

A QUICK TUTORIAL

After completing this tutorial, you will have performed some of the 
more  "significant"  functions  of  Image  Workshop  including,  among 
others, the opening, rotating, hiliting, labeling, enhancing, and layering 
of  images.   Simply  follow  along  in  the  program,  completing  each 
"bulleted" step as you go.

STEP Opening an Image File1

The first step of the tutorial will demonstrate the opening of an image 
file.  The image file that we will be using, "Colorado NDVI & Map," is 
found in the "•Images" folder included with Image Workshop. 

• Select open from the file pull-down menu, as 
   shown below in Figure 4.1.  

    Figure 4.1

• Next, find the "•Image" folder on your hard drive   
and select the "Colorado NDVI & Map" image from    the list.

You will then be prompted to enter some figures about the image in the "Open: Filename" dialog 
box, as shown below in Figure 4.2.  

       

      



      

Figure 4.2

Note:  The variables in the dialog box shown in Figure 4.2 must be entered every time you 
open an image file.  These will vary from image to image and they must be entered for 
Image Workshop to display them "correctly". 

• Now enter the X and Y dimensions for   
Colorado NDVI, which  are 486 and 362,    respectively.
 

Next, the bits per pixel should be entered.  Colorado NDVI & Map is an 8 bit image. 

• Enter an "8."     
  

If the image had header bytes within it, you would enter the number of header bytes for Image 
Workshop to ignore.  Since Colorado NDVI does not have any header bytes, a 0 may be entered.

• Enter a "0" in the header bytes to skip  
  box.  

The  Center Latitude and  Center Longitude can be entered to fix the center point.  Simply 
enter the center point of Colorado.

• Enter the Center Latitude and Center   
  Longitude of of Colorado in the boxes. 

  
The latitude range, or vertical range, specifies the scaled height of the image.

• The latitude range for this particular image is 
  about 6, so enter a "6." 

      



      
Now you must choose the image's projection by selecting the desired projection from pull-down 
Projection Menu.  For this example, you should use a linear projection.

• Select linear projection from the Projection 
  Menu, located on the right side of the dialog box.    

That last entry completed both the opening process and Step 1.  So click OK and move on to Step 2. 

• Click OK.

STEP Changing & Editing the Color Table2

Image Workshop allows you to display images using a variety of color tables.  When you opened  
the Colorado NDVI image in Step 1, the default "greyscale white on black" color table was used.  
You can now change the color table to "NDVI Colors" by selecting the NDVI Colors option from 
the Color Tables submenu within the Options Menu.    

• Select Color Tables from the Options Menu, 
  which shows the list of available color tables.

• Go down the Color Tables submenu and select 
  NDVI Colors. 

You will notice that not only the image changed colors, but the  Color Table Palette  and the 
Color Smear Palette now reflect the color change as well.    

But let's say that the NDVI Colors are not what you are looking for to display the image.  Perhaps 
you are particularly fond of a certain color.  The  edit color table  command will allow you to 
change the Color Table to your specifications.  

• First, select Edit Color Table from the Options 
  Menu.  

This will bring up the Color Table Editor.  The following figure depicts the top left section of the 
Color Table Editor.

      



      

Figure 4.3

As described in Chapter 3, the  Color Table Editor allows you to both edit and create  Color 
Tables.  In this example, you will go through a few features offered in the Color Table Editor. 

First, the  Color Table on the right side of the  Color Table Editor  can be used just like the 
regular Color Table, but this palette differs in that it allows you to manipulate the colors.

• Click on any one of the 255 color squares in the   
  palette.   

• Click picker on the left side of the editor.

This will open the Picker Menu, which allows you to change the attributes of the selected color.  
The left side of the Picker Menu contains tools for making minute changes in the selected color, 
whereas the right side lets you make these changes by visually picking a color from the color circle.  
For this example, you will shift the color's color spectrum with the scroll bar, located on the left 
side of the menu.

• Drag the scroll bar up and down to change the 
  color circle.  

Now, select a new color from the color circle with the selector.

      



      

• Select any color from the color circle with the 
  selector.

• Click OK.

The color that you selected with the picker will now be shown on the Color Table.  To revert to 
the original Color Table, simply click revert.

• Click on revert. 

Next, you can change the attributes of a range of colors in the Color Table Editor by clicking and 
dragging on the Color Table.

• Click on any one color and drag to select a range 
  of colors

This range can now be changed as a whole by using the functions on the left side of the  Color 
Table Editor.  In this example, the colors within the range will be reversed.

• Click on reverse.

This simply switched the placement of the colors within the range from top to bottom and vice  
versa.  

• Click on revert to go to the original Color  
  Table.

• Click on cancel to exit the Color Table Editor.

For a detailed description of these features, see Chapter 3 on page 21.

STEP Zooming In3

The next operation will allow you to get a closer view of the Colorado NDVI image.  Use the 
zoom command to increase the magnification factor used to display the Colorado NDVI image.
 

• Simply click on the zoom in box at the lower left 
  corner of the Image Window, as shown below in 
  Figure 4.4.  

      



      

Figure 

4.4
                                              

Now that you have gone from the 100% to the 200% view, move on to Step 4. 

STEP Selecting & Cropping an Area4

With the image still in the 200% view, you will now select a specific area of the image and create a  
new Image Window.  This is done with the area selection tool.  (Any area of any size will do for 
this exercise; however, you don't want to select an area so large that you just duplicate the original 
image).  

• Using the area selection tool from the tools 
  palette, select an area that you wish to work 
  with.  

• Click on a beginning point using the area 
  selection tool, drag the mouse to enlarge the 
  area, and release to select an end point.  

This area will now have "marching ants" surrounding it to illustrate your selection.  It's now time to  
create a new image from the selected area.

• Select crop selected area from the pull-down 
  edit menu.  

The new image, consisting of your selected area, will be opened and displayed automatically in a 
new Image Window.  This new image can be opened, closed, and manipulated just as any other 
Image Window in Image Workshop.   

      



      

STEP Zooming Out & Labeling a Point5

The next step is to return the Colorado NDVI image to the 100% view.  You can use either the  
zoom commands or click in the percentage display box.  You may use either of the following two  
options:

• Click in the zoom out box, as shown above in 
  Figure 4.4

- or -

• Click in the percentage display box 

Now that the image is in the 100% view, the next step is to pick and label a specific point on the  
image.  

First, select the label tool from the tools palette. 

• Next, using the location palette as a guide, find    
  the point 223 on the X axis and 107 on the Y axis.  

• Click on the point.  

This will label the point (223, 107) on the image with the value for the specific pixel, which is  
"177." This number also corresponds to the value shown in the location palette and the index 
number in the Color Table.  

Note:  In order to display a labeled point, you should be in at least the 100% view. 

STEP Computing Statistics6

The compute statistics command computes and displays the maximum, minimum, and average 
values, as well as the standard deviation for either a selected area or the entire image.  In this  
example, you will compute the statistics for the entire image.

• Select compute statistics from the pull-
  down Edit Menu.  

The following figure is displayed as the statistics are computed.    

      



      

                                                 

Figure 4.5
                             

Next, the Statistics dialog box, as shown below in Figure 4.6, is displayed. 

        

Figure 4.6

Now that you have the information from the Statistics dialog box, it's time to move on to Step 7.

STEP Enhancing the Image7

As stated in Chapter 2, an attribute of Image Workshop is the ability to illustrate certain features of  
an image through enhancement.

• Select enhance from the Enhance Menu.  

The dialog box, shown below in Figure 4.7, will appear.

      



      

  Figure 4.7

In this example, you will use the pre-defined enhancements.  The  auto function puts the  Color 
Table between the two endpoints of the Image Histogram.

• Click auto in the Enhancement Palette.

The Colorado NDVI image now reflects the enhancement.  Now, try the integrate function, which 
changes the slope of the Color Table to match the slope of the Image Histogram.

• Click on integrate.

Next, you can return the Color Table to 0-255 ("normal") by selecting the linear enhancement.

• Click linear.

To close the Enhancement Palette, click in the "close window box" in the upper right corner of 
the window.

• Click in the close window box

Now it's time to move on to Step 8.

STEP Hiliting a Range8

Step 8 explains how the hilite function can be used to hilite a specific value on an image. 

• Select the hilite command from the Options 
  Menu.  

      



      
The following dialog box is displayed.

                               Figure 

4.8

The hilite command, as described in Chapter 2 on page 11, hilites a specific user-defined range of 
values on the image.  To select this range, you need to enter the values of the pixels that you wish to  
be hilited in the set hilite dialog box.  

For this example, use the values 100 and 150 as minimum and maximum values.
 

• Enter 100 in the left box and 150 in the right box.

You may specify which color that Image Workshop uses to hilite the image with by clicking in the 
color box in the set hilite dialog box.  

• Select any color that is used the least on the    
  image, possibly white in the case of the Colorado 
  NDVI image 

• Click OK.  

All of the points on the image with values falling between 100 and 150 will now be shown in the  
color that you selected.

• Select turn off hilite from the options menu.

This turns off the  hilite and the original image is displayed.  Now you can move on to Step 9: 
Computing a 3-D Image.

STEP Computing a 3-D Image9

The next step in the tutorial is to create a 3--dimensional drawing of the Colorado NDVI image. 

• Select compute 3-D from the Enhance Menu.  

A window illustrating the computer's  progress will  then be displayed, and a 3-D dialog box is 
created when the calculations are 

      



      
finished.  The 3-D dialog box, shown below in Figure 4.9, contains a surface grid  of the image, as 
well as X,Y, Z, and Z-scale coordinates.  
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  Figure 

4.9

The surface grid can be rotated on its axis in any direction by clicking and dragging. 

• Click on one of the top edges of the image and 
  drag it upwards until it has rotated approximately 
  90 degrees.  

• Release the mouse and the new perspective is 
  automatically re-drawn.  

This gives you a side view of the image.   

The next step is to change the height of the image surface grid that you just rotated by changing the 
Z-scale.  For this example, the new Z-scale will be "3."  

• Enter a "3" in the Z-scale box and press the tab 
  key.  

Now it's time to create a 3-dimensional image using the data that you just entered.

• Click on create.

      



      
Image Workshop will now take a moment to create a 3-dimensional image of the Colorado NDVI 
image.  When the computations are finished, a new Image Window will be created to display the  
image.  Once the image appears on your screen, you can close the Compute 3-d dialog box.

• Click on done.

This new Image Window can be manipulated,  saved,  or  discarded before you move on to the  
Tutorial's final step.

STEP The Final Step10

The last step is simply for you to "fiddle" with Image Workshop: Sometimes this proves to be one  
of the best methods, and if you don't understand a particular function, the previous chapters offer  
definitions and examples.  

Try opening several different image files and perform different operations on each one.  Compare 
the effects of each tool with what is displayed on your screen.  This should help you to use Image  
Workshop more effectively.  Always remember that you do not have to save the changes to your 
images if you don't want to.

ABOUT THE TUTORIAL IMAGE
The Colorado NDVI image is 486 x 362.  This image is a particularly good example to work with, especially 
in the 3-D view.  Water and trees are easily viewed in this image as well.

      



      
 

Appendix A

This section contains the External Modules Programming Reference and the Commands Reference Card. 

      



      

PRELIMINARY DRAFT
This document needs much more work.  This is merely 
preliminary to get people started in using the External 
Modules.  -- BSP

Preface:
Before writing External Modules, you should be familiar 

with Macintosh Programming basics.  You should also be 
familiar with how to create code modules with whichever 
development environment you choose.  Two basic projects are 
included for Metrowerks CodeWarrior and Symantec C++ v7.0. 
This reference assumes that you will be using C or C++ for the 
module; however, you may write the software in any language.  
However, if you write it in anything other than C, you will have 
to convert the library traps from the C source included into 
whichever language.  Additionally, any external module 
developed may be freely distributed, etc.  The author of the 
external module has all rights to it.  The University of 
Colorado/CCAR makes no warranties and takes no 
responsibility for any external modules written.

Using External Functions

Setting up the Module:
The first step in creating an external function is deciding what your function 

will do.  Next, you must set up the function so that Image Workshop can help you 
achieve this goal.  You must create a resource of type ‘Xcfg’.  This resource is 
loaded along with your code resource and contains the configuration settings of 
your module.  This resource MUST have the same resource number as the code 
resource and be contained within the file.  All Code Resource files MUST have a 
filetype of ‘EXßP’ to be loaded by Image Workshop.  A ResEdit template is 
contained in the included file, “Xcfg Template.”  This allows you to use ResEdit to 
edit your Xcfg resource.

The first parameter is the number of images required by your module to 
function.  This is a short value.  Set this value to the minimum number of images 
your module requires.  If your module acts independantly of images, enter a value 
of 0.

      



      
The second parameter is the command number to append your function 

after in the menus.  This tells Image Workshop where in its pull-down menus it 
should put your function.  Look in the reference later for a table of command 
numbers.  For example, if you would like your function to appear after the Shadow 
Filter in the Filter submenu, you would enter a value of 4153.  If you enter a value 
of 0, then your module will automatically be appended to the Custom pull-down 
menu.  This value is ignored if you enter TRUE for the last parameter.

The last parameter is a Boolean value stating whether or not your module is 
a file reader/saver.  For custom file readers and savers, you would enter a TRUE 
value for this.  Otherwise, if it is a general module, enter FALSE.

Additionally, each module may have and use it’s own resources such as 
ALRT’s, DLOG’s, etc.

Using the Module:

THIS SECTION NEEDS MUCH FURTHER DISCUSSION

      



      

Image Workshop calls your external function through its main.  A message 
and data are passed through this main.  Traditionally on the Macintosh, code 
resources are not allowed to use Global Variables.  Therefore, Image Workshop 
will hold one handle for each external module so that it may keep whatever 
information it wishes.  This data must be allocated and deleted by each external 
module.  This is accessed through the variable myData.

All modules receive a ModuleInit message.  This function is called whenever 
Image Workshop boots up.  If you need to do any initialization at run-time, 
perform it here.  Additionally, when Image Workshop is quitting, you will receive a 
ModuleDispose message.  Here, you can clean up any memory, etc. that you may 
have allocated.

Depending on what your function does, you will receive different messages. 
Most modules will receive the ModuleExecute message when the user selects it 
from the menu.  This is your chance to perform the module’s function.

If it is a file reader/saver, you will receive a ModuleRead or ModuleSave 
function depending on the user actions.

If your code begins background processing through the call to Image 
Workshop, then you will receive a ModuleProcessTask function every few ticks 
(you can set the number of ticks) for you to process while the user is doing other 
things.  If the user cancels, you will receive a ModuleCancelTask message.  Each 
message is commented and explained in ModuleFunctions.c.

Every function called is passed four data members:
functions : This is an array of function call-backs to Image Workshop
data1: This is a Ptr of data that your function may need.
data2: This is a second Ptr of data that is passed into your function
myData: This is a handle for the module private use.  You can store any 

data into this handle.

Calling Image Workshop Functions

All Image Workshop callback functions are described in detail in the 
reference.  To call a function, dereference it from the functions variable passed 
into each function.  To call the function, GetTopImage use the syntax:

topImage = functions->GetTopImage();
This calls back to Image Workshop and returns the top image reference 

number.  All images are referenced using a short value.  To keep track of a 
particular image, you will use a reference number.

Reference

Command Constants:
The following table contains every command and their command numbers:

      



      
File
New 2
Open 3
Open Several 1054
Close 4
Save 5
Save As 6
Revert To Saved 7
Image Info 1052

      



      
Create Animation 1053
Page Setup 8
Print 9
Quit 1

Edit
Undo 16
Cut 18
Copy 19
Paste 20
Clear 21
Duplicate 2001
Select All 23
Flips & Rotations (submenu)

Horizontal 2101
Vertical 2102
Diagonal Right 2103
Diagonal Left 2104
Rotate Left 2105
Rotate Right 2106

Nudge (submenu)
Cannot access

Add Color Bar (submenu)
Vertical Right 2121
Vertical Left 2122
Horizontal Bottom 2123
Horizontal Top 2124

Crop Selected Area 2005
Crop Explicit Area 2006
Reduce/Enlarge 2007
Compute Statistics 2010
Preferences 2011

Options
ColorTables (submenu)

Cannot Access
Edit ColorTable 3001
Add Border 2004
Contour 3004
Combinations (submenu)

Add 3201
Subtract 3202
Multiply 3203
Divide 3204
And 3205
Or 3206
Xor 3207

Composites (submenu)
Maximum Value 3141
Minimum Value 3142
Average Value 3143
Median Value 3144
Red/Green/Blue 3145

Hilight 3011
Mark Coordinate 3013

Enhance
Enhance 4001
Borrow Enhancement 4002
Filters (submenu)

      



      
Median 4151
Mean 4152
Shadow 4153
Custom 4154

Change Pixel Value 2008
Shift Pixel Values 4005
Compute 3D 4004

Windows
Hide 6001
Hide All 6002
Show All 6003
Close All 6004
Rotate Windows 6005
Show Clipboard 22
ColorTable Palette 6007
Location Palette 6009
ColorSmear Palette 6010

Layer Manager Popup Menu
Layer Manager 6200
Hide Layers 6216
Hide All Layers 6217
Show All Layers 6218

Miscelanious Constants:

Function Reference:

CTabHandle GetColorTable(short imageNum)

Return a handle to the color table of a given image.

void SetColorTable(short imageNum, CTabHandle 
cTable)

Set the color table of a given image with the given color table handle.

short GetTopImage(void)

Return the image reference value of the current top image.

void PrintImage(short imageNum)

Print the given image.

void CloseImage(short imageNum)

Close the given image, prompting the user to save if changes were made.

GWorldPtr GetCurrentLayer(short imageNum)

      



      
Return a pointer to the offscreen gworld of the current layer of the given image.

Boolean BeginDrawing(short imageNum)

      



      
Set the port and lock the pixels of the current gworld layer used by the given 

image.  NOTE:  This call must be followed by a matching EndDrawing call; 
otherwise, you will leave the QuickDraw port dangling.  Additionally, this 
function will save the given image for undo.  This allows the user to cancel 
whatever your function has done.

void EndDrawing(short imageNum)

Finish the drawing of the given image.

short NewImage(Point *size, GWorldPtr gWorld)

Create a new image window with the given size and using the given gworld data.  
If gWorld is NULL, then a new, blank image will be created with the given 
size.

void GetGeography(short imageNum, LatLon 
*center, 

double *latrange, short *projection)

Get the geographical data from the given image.

void SetGeography(short imageNum, LatLon 
*center, 

double latrange, short projection)

Set the geographical data for the given image.

short LoadImage(StandardFileReply *reply, short 
imageNum)

Load an image.  The file described by the reply structure will be loaded by Image 
Workshop.  If you want it loaded into a new image, specify 0 for the 
imageNum.  Otherwise, specify an image to load the given file into a new 
layer.

short AddLayer(short imageNum, GWorldPtr gWorld)

Add a layer to the given image.  If gWorld is NULL, then a new, blank layer is 
added, otherwise the data from gWorld is added to the new layer.

short GetCurrentLayerNum(short imageNum)

Return the index to the current layer used by the given image.

      



      
short CountLayers(short imageNum)

Return the number of layers currently used by the given image.

void SetCurrentLayer(short imageNum, short 
layernum)

Set the current layer of the given image to the given layer index value.

void GetSelectionRect(short imageNum, Rect 
*selRect)

Return the selection rectangle that the user has currently chosen for a given 
image.  If selRect is returned NULL, then no selection range has been set.

void BeginTask(void)

      



      

Begin the task that the module is performing.  After BeginTask is called, the 
module function, ModuleProcessTask, will be called repeatedly until a call to 
EndTask is made.

void EndTask(void)

This will end the processing that is being made by the current external module.

void RedrawImage(short imageNum)

Redraw a given image to update any changes that may have been made.

      



      

Commands Reference Card

Borrow Enhancement  B⌘
Change Pixel Value  T⌘
Close  W⌘
Copy  C⌘
Cut  X⌘
Duplicate  D⌘
Edit Color Table  E⌘
Hide  H⌘
Image Info  I⌘
Mark Coordinate  L⌘
New  N⌘

Open    O⌘
Paste  V⌘
Preferences  Y⌘
Print  P⌘
Quit  Q⌘
Rotate Windows  R⌘
Save  S⌘
Select All  A⌘
Set Hilite  U⌘
Undo  Z⌘

      



      
Index
add border  23
add color bar  20
add layer  4   
area selection tool  6, 37
bits per pixel  15
borrow enhancement 25
change pixel value  26
circle tool 8
clear  18
color smear palette  11 

color table  9, 21, 34-35
combinations   24
commands ref. card  46
composites   24
compute statistics  21, 38
contour  24
contrast  23
copy  18
create animation 17
crop explicit area  19

crop selected area  19, 37
cut  18
delete layer 4
description box  16 
dropper 8
duplicate  18
edit color table 22, 34
edit image info 13, 16
edit menu  17
enhance  11, 25

enhancement menu  25
enhancement palette  11, 39
eraser  6
externals  i
file menu  15
file types  i
fill tool  7
filters  25
flips and rotations  18
font 28

freehand  8
generate  23
graphing tool  8
hand tool  6
hardware requirements  i
header byte to skip  15, 23
hide all windows  29
hide layer  3
hide window  29
hilite  11, 40-41

image info  16
image window i
index number 9
inspect  8
label   8
layers and layer mgr.  3-4
line size  30
line tool  7
load layer  4
location palette 9, 12

mark coordinate 25
new  15
nudge  9, 19
open  15, 32
open images display  30  
open several images  16
options menu  21
paint brush  7
patterns palette  10, 30
paste  18

pencil 7
percentage display  2, 38
picker  23
polygon tool  8
posterize  23
preferences 21
quit  17
rectangle tools 7-8
reduce/enlarge 19
rename layer  4

reverse  23
rotate windows  28
running Image Workshop  i
select all  18
set hilite  24, 25
shift pixel value 26
show all windows  29
sholw clipboard  29
show color smear  11
show color table  9

show layer  4
smear  23
text menu  28
text tool  6
tools palette  6
tutorial  31
undo  17
windows menu 29
X dimension  15, 19, 33
Y dimension  15, 19, 33

zoom commands  2, 36, 38

      


